Export Cuelist for gma3

“(OF) COURSE

This is simple tool to Export Cue List (Sequence) to the grandMA3.
Change Cue Number (renumber), Cue Fade or Info from within the application. You can also print your Cue List (Sequence).

Now you can export cue list from midi file. Midi file you can prepare in almost all music application like Pro Tools, Logic Pro, Cubase, Reaper etc.

In this help we show you how export cue list from Reaper.
Just import to Reaper multimedia file (music or video) you’re working on.
Prepare all Cues (Markers in Reaper) — light changes, accents, solos, etc. that you want to use in show.

Export Cuelist for gma3 will finish all work for you by importing to console Of Course:
— Cue List (Sequence)

—Sequence number

—Sequence name

— Page number

—Page name

— Executor number

— Cue Time — for Trigger Time

— Cue Fade

As simple as that!
Don’t miss that chance! Do not hesitate and try it completely for free!

Description:

Download and install "Reaper":
http://www.reaper.fm/download.php

Download and install "SWS Extension" for Reaper:
http://www.sws-extension.org/

1. Run Reaper.
2. Open View tab and set Time unit for ruler to Seconds.

& REAPER File Edit View Insert Item Track Options Actions Extensions Window Help [44.1kHz 24bit WAV : 0/2ch 512spls ~11/20ms]  100% @3 Sob. 4.01 01:11:03 jolo Q @® =

Mixer ¥¥M ID Description

Master Track X #M
Floating Mixer Master

+ Transport 8T
v Video RV

Monitoring FX

Docker
Toolbar Docker

Media Explorer
Routing Matrix
Grouping Matrix
Track Wiring
Project Media/FX Bay
Track Manager
Screensets/Layouts

v Region/Marker Manager
FX Browser
Media Item Properties

v Big Clock
Performance Meter
Peaks Display Settings

Navigator

Tempo Envelope XT

Scale Finder Regions
Virtual MIDI Keyboard XB v Markers

. A A 3 #~ Name Start End Length
Show/hide all floating windows X 3F

Cascade all floating windows

Time unit for ruler > Minutes:Seconds
Measures.Beats
Measures.Beats (minimal)
CoiE > |V Seconds

Zoom >

Always on top Samples

RF1 Hours:Minutes:Seconds:Frames
Absolute Frames
Secondary time unit | 2

Fullscreen

Filter: Clear
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3. Open Insert tab and insert new Track.
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ID Description

Insert new track

Insert new track at end of track list
Insert virtual instrument on new track...
Insert track from template

Save tracks as track template...

Remove tracks

Duplicate tracks

Move tracks to new subproject
Render/freeze tracks

MIDI track controls

Lock track controls

Lock track height

Free item positioning

Automatic record-arm when track selected
v Multichannel track metering

Track Manager (show/hide tracks)... 0 ¥M
Track color
Track icon

Track timebase Regions.
Track automation mode v Markers
Track performance options End  Length
Track layout

Envelopes

Track grouping parameters...
v Track grouping enabled

SWS Snapshots

Filter:

4. Open Insert tab and Import your media file.

& REAPER File Edit View Insert Item Track Options Actions Extensions Window Help [44.1kHz 24bit WAV : 0/2ch 512spls ~11/20ms]  100% @3 Sob. 4.01 00:39:17 jolo Q @ :

Media file... @ ID Description
New MIDI item

Empty item

SMPTE LTC/MTC Timecode Generator
Click source

gouto [FX New subproject

Marker
Marker (prompt for name)

goute || e [

Tempo/time signature change marker

Track

Multiple tracks...

Virtual instrument on new track...
Track from template

Regions
v Markers

End  Length

Filter:




5. Create a Cue List (Sequence) use the Markers and give the names for Cues. Important: don’t use comma (“,”) in cue name.
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ID Description
1 pre show
2 start

Add Marker

Name: [1i]

Position:  6.261

Set color... Reset color Cancel

Regions
v Markers

#~ Name End Length

M1 pre show
M2 start

6. Open Extension tab and open Marker List, click right mouse button and use the tab Convert markers to regions.

®  ® Marker List

ID Description

pre show

verse
chorus
frase

owm\:o’manm

solo

Rename

Set color...

Save marker set...
Delete market set...

| Copy marker set to clipboard

~ Paste marker set from clipboard

# i
N Reorder marker IDs

M1 Pl Reorder region IDs

M2 st

M3 hi Delete selected marker(s)
M4 hi Delete all markers

M5 hi Delete all regions

M6 hi

V5 Export formatted marker list to clipboard
Vi

e Export formatted marker list to file
5 Export forma

Convert markers to regions

Convert regions to markers

OOOOOO0O0O00

Dock Marker List in Docker
Close window




7. Save Reaper Projec
8. Open View tab and open Region/Marker Manager.
9. Click right mouse button and use the tab Export region/markers, name the text file (*.csv) and save it.

1 pre show 7 verse 8 chorus

9 frase

@ Region/Marker Manager

Regions.
Markers

#~ Name

D R1 pre show
markers/regions
Renumber in timeline order (markers, then regions)

Import regions/markers (replace existing)...
Import regions/markers (merge with existing)
Export regions/marke!

v Show track render menu nested by folders

v Seek playback when selecting a marker or region
Play region through then repeat or stop when selecting a region

Dock Region Manager in Docker

Close window

Your Cue List (Sequence) is ready and now. You can export it to the grandMA3 use Export Cuelist for gma3.
Run Export Cuelist for gma3.
Click tab Settings.

End  Length

4174 4174

6.261 2.087
8.348 2.087
10.435 2.087
12.522 2.087
14.609 2.087
22.957 8.348
27130 4174
31.304 4174
34.204 2.900

1. Set directories for Macro — grandMA3 OnPC Macro Folder or USB Memory Stick Macro Folder, default is: [Disk]\grandMA3\shared\resource\lib_macros\

2. You can also set default Trigger, Fade.
3. Save settings.

[ N J Export CuelList for gma3

Cue Cue Name set‘tings

Document folder (for repaer or music file)

/Users/makus/Documents/ExportCueList/Projects/

Macro folder : [Disk]\grand \ \lib_macros\)

/Users/makus/Documents/ExportCueList/gma: Browse

Trigger

first cue default Default fade time

GO Time 2.00

Purchase of subscription is possible only after logging into the account in the application. In addition to purchases, the account
gives the ability to synchronize settings, access information on new products, faster and more reliable contact with support. We
never send you email and Export CueList2 is 100% ad free.

You are logged as maciekh@gmail.com with Google account. (click to logout)

Version: Full version for one month

¥ show tutorial on StartUp

Reset to default

You are logged with Google account

Sequence number
2

Exec number
201

Page number
1

Sequence label
CueList

Page label
Page

Load file

Settings
Help

Our Apps

Filter:

Description
pre show
start

hit

hit

hit

hit

verse
chorus
frase
solo




4. Click tab Load file and select your Cue List (Sequence).

Directly from Reaper Project.

Export CuelList for gma3

Cue Name Trigger Time Fade Sequence number

2

Exec number
[ W Projects S Q Searct o0

Favorites Name Date Modified Kind Page number

[E) Recents M song.mid 25 maja 2020 14:54 Standa, 1

[ OfCourse_ExportTT.RPP 16 marca 2020 20:46 ReaperPr|
B OfCourse_ExportTT_regions.csv 16 marca 2020 20:46 po—| Sequence label
© Downloads CuelList

8 ownCloud

A\ Applications

Page label
= Movies Page

J7 Music

[0 Pictures

{2} makus

I iOSProjects

B TC&TT_2020
B gma31.1.4

@ OneDrive - iglo...

@ OneDrive

New Folder Cancel Load file

Settings
Help

You are logged with Google account Our Apps

Or, from exported text file from Reaper Project (*.csv).

Export CuelList for gma3

Cue Name Trigger Time Fade Sequence number

2

=, . o Exec number
- i Projects to3 Searct
201
Favorites Name Date Modified
(£ Recents IH song.mid 25 maja 2020 1
B OfCourse_ExportTT.RPP 02 5KB y
) ofCourse_ExportTT_regions.csv 16 marca 2020 20:46 303 bytes Sequence label
CueList

Page number
1
A\ Applications

© Downloads
3 ownCloud Page label
=1 Movies Page

J7 Music

)] Pictures

2} makus

I iOSProjects

B TC&TT_2020

8 gma31.1.4

@ OneDrive - iglo...

@ OneDrive

New Folder Cancel Load file

Settings
Help

You are logged with Google account Our Apps




Cue Name

Favorites
(£ Recents
A\ Applications
© Downloads
8 ownCloud
1 Movies
J7 Music
()] Pictures
{2} makus
I iOSProjects
I TC&TT_2020
B gma31.1.4

@ OneDrive - iglo...

@ OneDrive

New Folder

You are logged with Google account

As a result, you will see your Cue List (Sequence).

Cue Name
pre show
start

hit

hit

hit

hit

verse
chorus
frase

solo

You are logged with Google account

Trigger

Name

M song.mid
OfCourse_ExportTT.RPP

B ofCourse_ExportTT_regions.csv

Trigger
GO
Time
Time
Time
Time
Time
Time
Time
it

Time

O O OO O O

Export CuelList for gma3

Fade

Date Modified

25 maja 2020 14:54
16 marca 202 6

16 marca 2020 20:46

Export CuelList for gma3
Fade
2.00
2.00
2.00
2.00
2.00
2.00
2.00
2.00
2.00
2.00

W Projects & Q_ Searc

h

Sequence number
2

Exec number
201

Kd Page number

Standa...| 1

ReaperPrt

Sequence label
CueList

comma...\

Page label
Page

Load file

Settings
Help

Our Apps

Sequence number
2

Exec number
201

Page number
1

Sequence label
CueList

Page label
Page

Load file

Generate files

Print CuelList
Renumber
Settings
Help

Our Apps




Now you can change the Name, Number, Fade for cues.

Cue Name
pre show

start

Trigger

GO

Time

Export CueList for gma3
Fade
2.00
2.00

hit
hit
hit
hit

change fade time
change trigger
chorus change cue name
frase remove cue

verse

© ® N|lo o & @~

solo

=}

You are logged with Google account

Time
Time
Time
Time

2.00
2.00
2.00
2.00

OO O OO OO oo o

2.00
2.00
2.00
2.00

5. Do not forget to set Page number, Executor number, Sequence number, Sequence label, Page label.

Cue Name
pre show
start

hit

hit

hit

hit

verse
chorus
frase

solo

You are logged with Google account

Trigger
GO
GO

Time

Time

Time

Time

Time

Time

Time

Follow

OO OO O O OO O

Export CueList for gma3
Fade
2.00
2.00
2.00
2.00
2.00
2.00
2.00
2.00
2.00
2.00

Sequence number
2

Exec number
201

Page number
1

Sequence label
CueList

Page label
Page

Load file

Generate files

Print CueList
Renumber
Settings
Help

Our Apps

Sequence number
2

Exec number
201

Page number
2

Sequence label
Export_TT

Page label
Export_TT

Load file

Generate files

Print CuelList
Renumber
Settings
Help

Our Apps




can also print Cue List (Sequence).

Cue Name
pre show
start

hit

hit

hit

hit

verse
chorus
frase

solo

You are logged with Google account

And renumber the cue.

Cue Name
pre show
start

hit

hit

hit

hit

verse
chorus
frase

solo

You are logged with Google account

Trigger
GO
GO

Time

Time

Time

Time

Time

Time

Time

Follow

Printer:
Presets:
Copies:

Pages:

1

Export CuelList for gma3

Print
PrinterBiuro
Default Settings

Black & White
All

Export Cuel it for gmad - ExpertTT - Export_TT

10f1

PDF v  Show Details Cancel

Tin

41
2.0
2.0
2.0
2.0
2.0
83
41

O OO OO

41

Export CuelList for gma3

renumber cue

v all

start cue

from cue

start cue

new cue

renumber cancel

Sequence number
2

Exec number
201

Page number
2

Sequence label
Export_TT

Page label
Export_TT

Load file
Print Generate files
Print CueList
Renumber
Settings
Help

Our Apps

Sequence number
2

Exec number
201

Page number
2

Sequence label
Export_TT

Page label
Export_TT

Load file

Generate files

Print CuelList
Renumber
Settings
Help

Our Apps




Finally, you have two ways how to export Cue List (Sequence) to grandMA3.

Export by Macr:
Run Export Cuelist for gma3.

Click tab Settings.
1. Set directories for Macro — grandMA3 OnPC Macro Folder or USB Memory Stick Macro Folder, default is: [Disk]\grandMA3\shared\resource\lib_macros\

Export CuelList for gma3

Cue Name Setﬁngs Sequence number
pre show = 2
Document folder (for repaer or music file)
start Exec number
kus/D i j Browse
hit /User IS, tCuelist, j / 201

hit Macro folder (default: [Disk]\grandMA3\shared\resource\lib_macros\) Page number

hit / USUSB/grar J /lib_macros Browse 2

hit Sequence label
verse Trigger Export_TT
chorus first cue default Default fade time Page label
frase GO Time 2.00 Export TT

| g - A - -
col Purchase of subscription is possible only after logging into the account in the application. In addition to purchases, the account

bility to synchronize settings, access information on new products, faster and more le contact with support. We
you email and Export CueList2 is 100% ad free.

You are logged with Apple account. (click to logout)
Version: Full version for one month

+ show tutorial on StartUp

Reset to default

Load file

Generate files

Print CueList
Renumber
Settings
Help

You are logged with Apple account Our Apps

2. Click Generate files, choose what you want: marge or create sequence.

Export CuelList for gma3

Cue Name Trigger Fade Sequence number
pre show GO 2.00 2
start GO

hit Time
hit Time
hit Time
hit Time

verse Time

2.00 Exec number

2.00 Export CueList for gma3 201

2.00 Do you want to merge cue in all sequence? Page number
(marge don't import fade values)

2.00 2

2.00 Cancel No Sequence label

2.00 Export_TT

2.00 Page label

2.00 Export_TT

chorus Time
frase Time

solo Follow 2.00

O OO OO O

Load file

Generate files

Print CueList
Renumber
Settings
Help

You are logged with Apple account Our Apps




Click Open,

Your Cue List (Sequence) with selected Page, Executor, Trigger, Fade is ready to be imported using a Macro from folder in grandMA3 OnPC or from macro folder on USB Memory Stick!

Cue Name
pre show
start

hit

hit

hit

hit

verse
chorus
frase

solo

Trigger Time

Favorites
[E) Recents
A\ Applications
O Downloads

ownCloud
Movies
JJ Music
[ Pictures
{2} makus
I iOSProjects
0 TC&TT_2020
8 gma31.1.4

Export CuelList for gma3
Fade

# lib_macros

¥ Do you want open folder after generate macro?

New Folder Options

You are logged with Apple account

Cue Name
pre show
start

hit

hit

hit

hit

verse
chorus
frase

solo

Trigger
GO
GO

Time

Time

Time

Time

Time

Time

Time

OO O OO OO

Follow

You are logged with Apple account

Export CueList for gma3
Fade
2.00
2.00
2.00
2.00
2.00
2.00
2.00
2.00
2.00
2.00

Q Searct

Date Modified

Export CuelList for gma3

Copy file M.xml from file:///Volumes/MAKUSUSB/
grandMA3/shared/resource/lib_macros/ to [Disk]
\grandMA3\shared\resource\lib_macros

Create new Macro, choose import, select correct drive

and choose file M.xml, after import run this Macro.

OK

Sequence number
2

Exec number
201

Page number
2

Sequence label
Export_TT

Page label
Export_TT

Load file

Generate files

Print CueList
Renumber
Settings
Help

Our Apps

Sequence number
2

Exec number
201

Page number
2

Sequence label
Export_TT

Page label
Export_TT

Load file

Generate files

Print CueList
Renumber
Settings
Help

Our Apps




3. Run your show on grandMA3.

cuelist] Display 1

Fixture

Preset

3

Sequence
Sheet

Tracking
Sheet

Phaser

I@ Admin[Fixture]> = )
p—

) : Grand
MAtricks Master

100.0%

Sync

Absolute Relative Fade Delay Speed Phase Repeat  Accel Decel  Transitio Width 4= =

Single S\
Step Feature

off

Percent

. Create Macro, and choose Import.

onPC 1.1.4.2 [cuelist] Display 1

Lock No Name Command Enabled AddToCmdl Execute

New MacroLine

Insert New MacroLine Macro 1 60

. List
Oops References

E=  Admin@ShowData/DataPools/Default/Macros/Macro 1> | 2
p—

~ Grand
MAtricks Master

100.0%

Feature Absolute Relative Fade Delay Speed Phase  Repeat Accel Decel  Transitio Width « »

ScreenY
Display 1
. Screen X

Percent Display 1




5. Choose drive, and select M.xml file.

¢ onPC 1.1.4.2 [cuelist] Display 1

s |1

Filter:} E= Clear

Lock No Name FileName FileSize

SL 1 CuelList.xml CueList.xml 163B 15
M.xml M.xml 2.8kB 15

6. Now run this Macro.

onPC 1.1.4.2 [cuelist] Display 1

Name Command Wait Enabled AddToCmdl Execute

MacroLine 1 Delete Sequence 2 /nc

MacroLine 2 Store Sequence 2 Cue 1 "pre show" CueFade="2.00"
MacroLine 3 Store Sequence 2 Cue 2 "start" CueFade="2.00"
MacroLine 4 Store Sequence 2 Cue 3 "hit" CueFade="2.00"
MacroLine 5 Set Sequence 2 Cue 3 TrigType=Time
MacroLine 6 Set Sequence 2 Cue 3 TrigTime="2.087"
MacroLine 7 Store Sequence 2 Cue 4 "hit" CueFade="2.00"
MacroLine 8 Set Sequence 2 Cue 4 TrigType=Time

O 0O N O O A~ W N

MacroLine 9 Set Sequence 2 Cue 4 TrigTime="2.087"

o

MacroLine 10 Store Sequence 2 Cue 5 "hit" CueFade="2.00"

Insert New MacroLine Import Macro 1'Export_TT" GO

List
Oops Export References

E=  Admin@ShowData/DataPools/Default/Macros/Macro 1> E3 }
heut

~ Grand

MAtricks Master

100.0%

Feature Absolute Relative Fade Delay Speed  Phase Accel Decel  Transitio Width 4= =

‘ Screen Y
Display 1
. Screen X

Percent Display 1




Your Cue List (Sequence) with selected Page, Executor, Trigger, Fade is already in show on grandMA3!

cuelist] Display 1

1

Export_TT

Export_TT

I E= Admin(Fixture]

Sync

Single o
Step Feature

off

Percent

onPC 1.1.4.2 [cuelist] Display 1

Show Track
Edit{Sequence}2{ExportaTily Steps Sheet

Allow Trig Trig Trig  Trackin¢p, ratior Sync  Morph Cue Snap

Lock Name Release Assert Duplicat Type Time Sound Distance Fade

Delay

Absolute Relative Fade Delay Speed Phase  Repeat Accel Decel  Transitio Width

MAtricks

-

Auto
Scroll

Cmd

Indiv

Delay Delay Fade

Fixture

Preset

3

-

Settings

Indiv

Delay Duratior

Sequence
Sheet

Tracking
Sheet

Phaser

= )

Grand
Master

100.0%

O

Indiv

Cmd

0 0

=

Time
Time
Time
Time
Time

Time

O 0 N O O &~ W N

Time

=
o

Follow

OIN N N N N N N NN N|O
OIN N N N N N N NNN
oOojlo o o o o o o o o o

Admin[Fixture]>

Sync
-

Single ; Edit
Step CueTiming ECILEEO « CueZero m <

CuelnFade CuelnDelay SnapDelay
off 0 ) 0
. CueOutFade ‘ CueOutDelay
Percent None None
Contact us:

support@ofcourse.com.pl
v1.0.0.2

oOjlo0o O ©O O O O O O o oo

O|lo o o O ©O O O O O oo

MAtricks

m

Screen'Y
Display 1
Screen X
Display 1

M
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Grand
Master

100.0%




